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I.

Features and advantages.

The 123WaxRing system is a combination of CAM software and a fixture that makes it
very easy to machine wax models of complicated ring designs. The software is a wizard
that runs in the DeskProto CAM program. The fixture is a high accuracy aluminum
piece, designed to be used on the rotation axis unit of the Roland JWX-10 Jewela CNC
milling machine. It can very well be used on other machines, though an adapter may be
needed.
In order to use the 123WaxRing system you need to have:
- a 3D CAD system to create your ring designs. All current CAD programs for jewelers
are supported, like 3Design, JewelCAD, Matrix, Rhino, TechGems. and many others
(geometry import as STL file).
- a CNC milling machine with a rotation axis. The fixture has been designed for a
Roland machine (JWX-10 or MDX-40), still other machines can be used as well using
an adapter. See the example in paragraph II.1.
- pre-shaped wax-blocks as delivered with the fixture. You are also perfectly free to
create your own wax blocks.
- a cutter. We are enthusiastic about conical cutters (for instance as offered by
bitsbits.com): they combine a long cutting length with a very small tip. Other cutters
like flat and ballnose can be used as well.

The principle of the system is very simple:
1. Machine side 1, standard XYZ machining.
2. Turn the block upside down and machine side 2, standard XYZ machining.
3. Machine the outside of the ring using the rotation axis (XZA machining).
All three steps can be done with the same workpiece zero point and with the same
cutter.
In the center of the ring a cylinder wax support block will remain un-machined, the
core, that is used to fixture the model in all three orientations. The wizard will prepare
the toolpaths for you: you only need to place the wax block three times, the rest is done
automatically.
Advantages:
- Wax models with undercuts can be created by machining from several sides (in
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several orientations).
- For all orientations the model is clamped on the same fixture, resulting in a very high
accuracy. No need to change or adapt the fixture.
- The fixture is very stable: no assembly where the parts can move and introduce
positioning errors, no vibrations during machining. This will result in a superb surface
quality.
- No need to change the cutter: all milling can be done with a conical cutter
(competing systems also need a straight cutter to machine the core).
- All orientations are done with the same workpiece zero point. So this needs to be
set only once !!
- As a result the system is very easy to use: take a block, fixture it with just one screw
and start machining.
- The system also is very fast: preparing the toolpaths and machining will take less time
than with competing solutions.
- Minimum loss of wax: no oversized wax blocks are needed for clamping purposes.
- The positioning of the reference pins is such that the wax block cannot be incorrectly
positioned. Only for step three there are two options, and the wizard has added an extra
toolpath to prevent error here.
- After completing the wizard all DeskProto parameters are available to fine-tune your
parameters. In most cases this is not needed, still this flexibility makes more complex
pieces possible too.
- DeskProto offers an automatic feedrate reduction in high chip load situations.
- The wizard is written in a simple script language, so it is editable: any skilled user
can change and/or elaborate the wizard when needed.
- The toolpaths are completely prepared by the wizard: no need to manually select
macros for special functions that need to be performed (like machining the core).
- The toolpaths can be sent directly to the Jewela machine from DeskProto: no need to
save an NC file first and then use a separate program (Dropout) to send them to the
machine.
- On the Jewela machine the fixture can be used with the rotation axis unit in the
rightmost of the two possible positions. So the small orange table on top of the
rotation axis can be used for XYZ milling as it is within the working area. This means
that both XYZ machining and rotation axis machine are possible without reconfiguring
the machine.
- It also is not needed to change the BIOS of the Jewela machine: it can be used “as is”.
- The same fixture can also be used for two-sided milling (pendants, brooches etc). See
the chapter on the 12WaxModel Wizard. So changing fixtures is not needed.
When compared to making a wax model using an additive process (sometimes called 3D
wax printing) advantages of the 123WaxRing system are the better surface quality of the
model, and the ability to also process STL files that do not contain a perfect solid.

As so many innovative new features are incorporated in this system, the 123WaxWizard
is protected by a patent (pending).
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II. Installation and Setup.
II.1

Included items

Please find included in your 123WaxRing kit the following items:
1 x 123WaxRing fixture
3 x hexagonal mounting screw (size M4 x 10 mm)
3 x hexagonal screw for mounting wax blocks (size M4 x 16, 20, 25)
3 x washer size M4
2 x Conic 123WaxRing cutter (shaft diameter 3.175 mm, included angle 20 degr, flat tip
with diameter 0.1 mm). This is "Bits & Bits" cutter No. 815-PR20/.004
8 x round wax disk 10 mm thick
3 x round wax disk 15 mm thick
2 x round wax disk 20 mm thick
3 x square wax block 10 mm thick
1 x 123WaxRing documentation.

II.2

Mounting the 123WaxRing fixture on your
machine.

On the Roland JWX-10 en MDX-40
machines the fixture can be directly attached
to the rotation axis using three screws. See
the Roland documentation for more
information. Note that first the Sensor part
needs to be mounted on the rotation axis, in
order to find the Y=0 position. After that the
123WaxRing fixture can be attached.
On many USA-made machines a Sherline
type rotary table is present. For these
machines we offer the “Sherline-to-Roland
adapter”: see Appendix A.3 of this manual
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On other machines it may be possible to clamp
the adapter in a 3-jaw chuck or 4-jaw chuck on
it’s rotation table. The fixture can be clamped
directly, or an adapter can be used to create
some distance between waxblock and chuck.
The Sherline adapter just mentioned can very
well be used for this purpose. Attach the fixture
to the adapter and mount the combination in the
jaws of your rotary table’s chuck. See the
illustration that shows adapter and fixture
mounted on the rotary table of a Taig machine
(picture courtesy of caducopia.com).
When mounting the fixture you need to make sure that:
1) the axis of the rotary table (A) is perfectly parallel to the X axis of the machine.
2) the fixture/adapter is being held perpendicular to the rotary table.
3) the adapter is properly centered in the chuck, i.e. the axis of the fixture/adapter is
coincident with the A axis. With a four jaw chuck like shown in the picture an eventual
offset can be corrected.
For more information see the mounting specifications in appendix A.2

II.3

The workpiece zero point.

Setting an accurate WorkPiece zero point is the key element in order to create accurate
wax models with the 123WaxRing system. This is true for all 4 axes involved: X, Y, Z
and A. An error as small as 0.1 mm or 0.1 degree will be visible in the resulting model.
Note that accuracy is relative: an error of a few 1/100 mm is acceptable as this will also
be the tolerance of the machine. A toolmaker will find this a very low accuracy, for a
ring model it will be OK.
As you will see setting the zero point is a complex procedure, without the ease of use
that was promised for the 123WaxRing system. Allow yourself at least an hour for this
procedure, even more when you use an adapter. Note that this zero setting needs to be
done only once. You can ask your reseller to do so for you after installing the system.
Then you can skip this paragraph and start milling a ring model. And that will be very
easy, as promised.
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The illustration above shows the 123WaxRing fixture and the position of the WorkPiece
Zero point (WP zero). The fixture is accurate within 0.001 mm, so any inaccuracies will
be caused by the zero point setting or by the machine.
The workpiece zero point needs to be set as follows:
Y, Z = 0 - on the rotation axis. For Z the tip of the cutter counts.
X = 0 - at the right side of the fixture (at the vertical fixturing surface)
A = 0 - with the top surface (the horizontal fixturing surface) horizontal.
So the zero point is on the rotation axis at the right end of the fixture (not counting the
reference pins), see the red crosses in the illustration above.
The horizontal surface is 8 mm higher (8 mm along Z), and its center hole there is 18
mm left of the zero point (18 mm along X). The 123WaxRing Wizard in DeskProto will
automatically create all toolpaths relative to this one zero point. Also the toolpaths for
Side 1 and 2: changing the zero point is not needed.

II.4

Setting the zero point on a Roland machine.

The Roland JWX-10 and MDX-40 machines feature an automatic zero finding
procedure for Y and Z. You need to zero the Y axis first, as only after that the fixture
can be mounted, which is needed to zero X and A.
Setting Y = 0:
The standard procedure of the Roland machine may be followed:
- Install the sensor on the rotation axis and connect the sensor cable to the sensor.
- Insert a cylindrical shape that is sufficiently long in the collet chuck.
- In the Roland JWX-10 panel (or MDX-40 panel) select “Set the Y-origin at the center
of rotation”.
For further information see the documentation that came with your Roland machine.
Setting Z = 0:
Here as well the standard procedure of the Roland machine may be followed:
- Install the sensor on the table and connect the sensor cable to the sensor.

8

- Insert a cutter in the collet chuck.
- In the Roland JWX-10 panel (or MDX-40 panel) select “Set the Z-origin at the center
of rotation”.
The Z=0 will of course be different per cutter.
We have found that the automatic zero finding procedures for Y and Z on the Roland
JWX-10 and MDX-40 may be insufficiently accurate. For instance a difference of 0.1
mm in Z between the height of the sensor and the actual rotation axis is possible (the
working table is not exactly plane and horizontal). In case you face any accuracy issues
then you can follow the instructions for fine-tuning in the next paragraph.
Setting the zero point for X and A is done following the procedure described below,
which is the same procedure for Roland and for non-Roland machines.
Setting X=0:
For X the old manual trick with the thin sheet
of paper has to be applied (we use cigarette
paper):
- Insert a cylinder shape in the collet chuck
(you can mount a cutter upside-down).
- Move the cutter to the right side of the fixture,
using the movement buttons on the Roland
JWX-10 panel .
- Move the cutter to the Y=0 position, and to a
Z-position that allows the cutter to touch the
fixture in the next step.
- now carefully move to the left, with the paper
between the cylinder cutter and the fixture. See the illustration. Travel to the left step
by step until the paper can no longer be moved. Now you know that the cutter touches
the fixture, so that you are R mm right of the X=0, where R is the Radius of the cutter
(or cylinder shape).
So now move your cutter upward till it is above the fixture, move to the left R mm and
press the SET button at “Set the X-origin here.
Note 1: Be very careful when moving the cutter towards the fixture. The JWX-10 will
suddenly increase speed after some time, which
may cause a collision with the fixture !!! So
press the movement buttons only for a second
or so, release, then press again, etc.
Note 2: Of course the paper has a thickness of
it’s own. Since for cigarette paper this is below
0.1 mm a correction is not needed, when using
thicker paper it might be.
Setting A=0:
For A the same trick has to be applied.
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- Insert a cutter in the collet chuck (use a ballnose or one with a sharp point).
- Move the cutter to Y=0, above the horizontal surface of the fixture, using the
movement buttons on the Roland JWX-10 panel. Move to an X not close to the two
positioning pins.
- now carefully move downward, with the paper between the cylinder cutter and the
fixture. Travel down step by step until the paper can no longer be moved. Now you
should be exactly at Z=8.0 mm, as this horizontal surface is 8 mm above the rotation
axis.
This information can be used to set the Z=0 position on non-Roland machines. For
Roland machines is can be used to fine-tune the Z=0 position when the automatic
procedure would prove to be insufficiently accurate.
Back to setting A=0: now do the same at Y=15 mm.
It will be clear that when the fixture is on the correct A=0 orientation both Zmeasurements will be equal. In case not, then from the difference between both Z
measurements you can calculate the angle that needs to be rotated for a true A=0. An
angle of 1 degree will result in a Z-difference of 0.2618 mm, as 15 * SIN(1) = 15 *
0.01745 = 0.2618 mm.
So for instance when the difference in Z is 0.43 mm, you need to rotate A 0.43/0.2618
= 1.64 degr. (if Z Front is greater than Z Back, rotate A in the counter-clockwise
direction; whether this is positive or negative is machine dependent). When you have
done so, press the SET button at “Set the A-origin here.
An alternative procedure for setting A= 0 is sweeping a dial indicator back and forth
across the 123 WaxRing’s horizontal fixturing surface, measuring Z at the extremes.
Rotate the fixture round A in order to correct the difference between Z Front and Z
Back. Repeat until the difference is reduced to zero, then Zero A.

II.5

Setting the zero point on a non-Roland machine.

As non-Roland machines will not offer the automatic zero finding procedure for Y and
Z as described above, the workpiece zero point needs to be set differently. We cannot
give a detailed set of instructions as we do not know which machine you are using.
Setting Y=0: we hope that your machine came with some guidelines how to set the Y=0
on the rotation axis. If not then you can use the cigarette paper trick described above:
touch front side and back side of the fixture and place Y=0 exactly halfway.
Setting Z=0: here again perhaps your machine supplier has given guidelines how to do
this on your machine. For Z=0 the tip of the cutter needs to be exactly on the rotation
axis. If such guidelines do not exist, then for Z=0 you can make you cutter touch the
horizontal fixturing surface of the fixture (as just described): Z=0 should be set exactly
8.0 mm below that surface.

10

Setting X=0 needs to be done exactly like described above for the Roland machine.
Setting A=0 also needs to be done exactly like described above for the Roland machine.

II.6

Fine-tuning the zero point (optional).

As just explained, the standard procedures to correctly set the workpiece zero point are
not always sufficiently accurate. In order to fine-tune the position of the zero point you
can use the optional procedure described below.
The following tools will be needed for fine-tuning:
- caliper (for example, electronic digital caliper in 0.01 mm or 0.0005 in.)
- endmill (for example, 2 mm or 1/8 inch endmill)
- piece of thin paper (for example, cigarette paper)
- a few 123 WaxRing wax blocks (a minimum of 3 on-hand is recommended)
- masking tape, optional
- dial indicator, optional
For fine-tuning a standard block wax is used, as supplied with the 123WaxRing fixture.
You will machine this block from a few sides, and by measuring the results you can
accurately see any small misalignments that are still present after step one. For these
tests you need to use a cylindrical cutter (an endmill is best, though for X and Y a
ballnose can be used as well): a conical cutter will not work here.
The toolpaths needed are supplied in a DeskProto project called 123WaxRing
Calibration.dpj
Three parts are present: “X zero calibration”, “A and Z zero calibration” and “Y zero
calibration”. Each part contains two 2D Operations to generate the toolpaths. Open this
project in DeskProto and calculate all toolpaths.
Note that these project have been prepared without a machine: so your default machine
will be selected. If that is not the machine that you are calibrating, you need to select a
different machine in the Part parameters. It might also be a good idea to check the
Feedrate and Spindlespeed to see that they are appropriate for machining wax on your
machine. If the cutter specified is not available, you may want to improvise, but be
careful, the diameter must be less than 6 mm and the flute length greater than 6mm (for
example, users of tooling in English units can use an 1/8 inch diameter endmill).
Make sure to rise you cutter to a Z-level well above the fixture before starting any of
these calibration toolpaths.
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Finetuning X = 0:

For the X-axis check, a flat surface is machined at the right side of the block (Operation
“Side 1 (right)”). To do this you need to make the other operation of this part invisible
by double clicking it’s line in the tree. When you then give the command “Send current
toolpaths to machine” (Create -> Extra), only the visible toolpaths will be done.
Next the block is turned upside down, and a second surface is machined, now at the left
side of the block (Operation “Side 2 (left)”). To do so you have to make the other
operation the invisible one.

The difference between these two surfaces is twice the misalignment. So measure the
difference with a caliper, see the illustrations above, and divide the result by two to get
the misalignment for X. When the second surface is on the right of the first, then your
X=0 is too high, when it is at the left then X=0 is too low.
Now move the cutter to X=0, shift over the misalignment just calculated, and press the
SET button at “Set the X-origin” here.
Do not continue with the Y-axis now: the Y-axis has to be fine-tuned last, after the A
axis has been done. Reason is that an error on the A=0 will influence the Y-axis results:
when A=0 is not correct then the complete waxblock also will be positioned too far
forward or back.
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Finetuning A = 0 and Z=0:

The A-axis and Z-axis fine-tuning is combined. Use the Part “Z and A zero calibration”
to machine a small flat surface on the front and on the back of the wax block. Both
Operations may be sent to the machine in one go.
Now measure the thickness of the block at these two surfaces: it should be 8 mm. A
difference indicates an error in A=0 (see above), an incorrect (average) value indicates
an error on Z=0.

Finetuning Y = 0:

Finally, the Y-axis is done just like the X-axis. The only difference is that when flipping
the wax-block over from front to back, the fixturing screw can no longer be used, and
the wax-block has been shifted 5 mm along the Y-axis. So for the second side the waxblock cannot be fixtured with a screw. Machine without the screw, if needed you can
use some tape as in the illustration above. Just like with X: divide the difference that
you measure by two and move the Y axis over that distance. I.e. if Y Front is closer to
the center than Y Back, then move to the Front (negative direction) else Back (positive
direction). Finally reset the Y=0 there.
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II.7

Some additional notes.

The Roland machine will remember the zero positions that you have set (in fact most
machines will), and will automatically move to (X=0 , Y=0 , Z=Max) when you switch
it on. Note that it will NOT move to A=0 : you will have to do so manually after
starting the machine. This is needed as Side 1 and 2 have to be machined with A=0.
For Roland you can also find the coordinates of
the workpiece zero point (so it’s position
relative to the machine’s working area), in
order to write these down. When you press the
VIEW button on the machine, the machine will
move the cutter to the corner of it’s working
area. So the X, Y and Z positions that you now
see in the Roland Panel (see the illustration) in
fact show the position of the Workpiece zero
point that you just set, only with a false minus
sign.
The View button will not move the A-axis: here
the position of your zero point is only visible
after starting the machine.

II.8

Software Setup.

In order to use the 123WaxRing Wizard, the DeskProto software (Version 5.0 or higher)
needs to be installed on your PC. The first time DeskProto is run it will ask you which
milling machine you use, and which units. Choose the correct default machine as the
wizard will automatically use this default machine. Also choose metric units (mm): the
DeskProto wax wizards will not accept inches as also (“even”) in the US jewelers work
in mm.
Incorrect settings can be altered any time later:
- The default machine can be found in the Default Part Parameters (Options menu).
- The units can be found in the Preferences (Options menu).
DeskProto is the CAM software that will calculate the toolpaths. You will also need to
install the Control software that came with your CNC milling machine, needed to read
the NC toolpath file from DeskProto and make the machine follow the toolpath. Also
important functions like setting the workpiece zero point can be found in this Control
software.
For Roland machines this control software comes as a Windows Printer driver that
needs to be installed. The Roland Control panel that was mentioned is a part of this
printer driver. Create a shortcut to this Control panel as follows:
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- Windows Start button -> choose Printers and Faxes
- Right click the line of your Roland machine and choose Preferences
- Tab page Options, press the button “Create Shortcut” after “Operation panel”.
If you cannot find this button you might need to download and install a newer version of
the Roland Printer driver from the RolandDG.com website.
This Operation panel or Control panel is in fact the Roland Control Software.
For Roland machines one more setting has to be made in the DeskProto software, as for
these machines it is possible to directly send the toolpaths from DeskProto to the
machine, without first saving them in an NC program file.
The setting can be found in the DeskProto Preferences (Options menu). Go to Tab page
“NC output” and select “Use Printer Driver” as NC output device. Now use the Setup
button to select the printer driver of your Roland machine. This setting configures
DeskProto to send the toolpaths to the machine using the correct driver.
Now you can generate toolpaths using the 123WaxRing wizard in DeskProto.
Put a new wax-block on the fixture, send the toolpaths to your machine and enjoy !
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III. Creating a wax model.
III.1 Running the 123WaxRing Wizard.
Start DeskProto and start the 123WaxRing Wizard. When the wizard dialog does
automatically pop up on start you can find it in the File menu.
This documentation will provide some background information for each Wizard screen:
Load Geometry: read the ring geometry as created using your jewelry CAD program.
DeskProto can read STL, DXF and VRML files, so any 3D CAD program can be used.
Rotate Geometry: the ring geometry needs to be aligned with the rotation axis. Look at
the thin green lines that indicate the cylinder shaped wax disk.
Transformations like scaling and centering are not possible in the wizard. When
needed you can exit the wizard, achieve the transformations as needed using the
DeskProto Part Parameters, and choose “Save geometry as” (File menu) to save the
geometry including these transformations.
Wax Block: a few sizes standard wax disks were included in your 123WaxRing kit,
each already with the three holes needed for fixation and for alignment. You can order
extra disks, and you are of course also free to make your own wax disks in any different
size. Take care not to make the block thinner than 6 mm (then the positioning pins
would be too long) nor larger than 38 mm (then the left side would collide with the
fixture).
The thickness of the block needs to be exactly as specified (also parallel top and bottom
surface), for the other dimensions the actual block may be larger than specified.
Spokes (support blocks): you need to enter the inside radius of the ring here, to be used
for the length of the spokes. This same value is also used as the maximum depth of the
cutter when machining part 3 (rotation axis machining).
You can read coordinates on the screen to quickly see the inside radius of your ring:
read the Z-value in the bottom right corner of your screen while moving the cursor up
and down (so along Z).
DeskProto can apply four spokes (+) or three spokes (T), the latter used when one spoke
would distort details like a bezel.
You can also tell DeskProto not to use spokes by entering “0.00" for Spoke Diameter.
Then you can define your own custom spokes in your CAD software.
Cutter: you can choose any cuter that is available in the DeskProto library of cutters.
We have very good experiences with conical cutters, for instance as supplied by
www.bitsbits.com For the Spindle speed (rotation speed of the cutter) and Feedrate
(movement speed of the cutter) the DeskProto default values will be used. In the
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DeskProto cutter library (Options menu) you can also for any cutter set speeds to be
automatically used when that cutter is selected.
The Distance between the toolpaths is a compromise between quality and milling time.
As the Conic 123WaxRing cutter that comes with the fixture has a tip diameter of 0.1
mm, the distance between toolpaths may not be larger than 0.1 (in most cases we use 0.1
mm).
Parts: the three orientations in which the wax model is machined are programmed in
DeskProto using three Parts, with different geometry transformations for each part. The
wizard also sets correct Translations for each part, making it possible to mill all three
sides using the same workpiece zero point (indicated on the screen by the blue cube).
For Parts 1 and 2 also an extra cylinder shape is added on top of the core support block,
to make absolutely sure that the cutter does not touch the fixturing screw at that
location.
In Part 2 an extra operation is added: a 2D Operation that will create a notch in the core
support block. This notch makes it possible to distinguish between both sides and thus
to correctly mount the wax disk for milling Part 3.
Roughing: will result in a better surface quality. As the extra roughing operation
removes most material, the cutter will make very run very smoothly when finishing.
Machining in one go is only possible when the cutting length of the cutter is sufficiently
long to machine the full depth needed. Adding a roughing operation will save time only
in case the ring is too thick to machine in one go.
Roughing parameters: these are of course only needed when in the previous question
you have selected the use of a roughing operation We mostly do so, and then select a
skin thickness of 0.2 mm (to be removed when finishing) and a distance between the
toolpaths of 0.21 mm (much larger is not possible as then the chips will remain
connected to the model). The Layer height can be set that all layers will have about the
same thickness. For wax, any layer height is acceptable up to 9 mm (the cutting length
of this cutter).
Calculate: this button will start toolpath calculations for all three parts. For each
Operation a progress bar will be shown.
Send toolpaths to the machine: using the button you can write the NC files for the
three parts. DeskProto already has suggested suitable names. Note that for a Roland
machine this is not needed as you can send the toolpaths to this machine without first
saving a file.
After finishing the wizard you can fine-tune your results: change any Part parameters
and Operation parameters that were not available in the wizard. You need to be careful
with the segments and the translations as changing these may cause problems. You can
change for instance parameters like Strategy, Feedrate, Free movement height, Dynamic
feedrate control, etc. Of the Operation segments you can change the Z-Min (cutting
depth) when needed. Note that after changing any parameter you will need to save a
fresh NC file.
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III.2 Machining a wax ring on the 123WaxRing
Fixture.
The result of the Wizard will be a DeskProto screen showing toolpaths for your ring, in
three orientations as defined by the three parts in the tree on the left of the screen.
If not already present, load the correct cutter and (re)set the Z=0 position for this cutter.
For a Roland machine, make sure that the View button on the machine is not active.
On the Roland Control panel check the value for A. This has to be 0.00 degrees. If any
other value is shown, rotate using the A movement buttons until A is zero (the machine
does not automatically move to A zero as it does for X, Y and Z.
Take a wax block of the correct size and place it on the fixture, with the two reference
pins in the holes in the wax block. It does not matter which side of the block is up at this
point. Use the hexagon screw and a washer to fix the wax block (see the illustration).
Do not use much force: hand tight is OK.

For a Roland machine, in the Tree on the DeskProto screen make the first part (“Part 1:
flat”) current by clicking the lamp on it’s line (was off=grey, will be on=yellow). You
now will see the toolpaths for Part 1. Next in the Create menu choose Extra, and next
“Send current toolpaths to machine ...”. After a confirmation the machine will start
cutting Side 1, as shown in the illustrations above.
For non-Roland machines you need open the NC file for the first part (that has just been
saved) in the control software that came with your machine.
You can see that this conical cutter with a sharp angle (the cutter shown has a 20 degree
included angle) can machine to full depth in one go. When you have selected more
layers in the wizard or roughing and finishing, the toolpaths will of course be more
complex. No worry: everything is done automatically.
When the toolpaths for Side 1 are finished, press the View button on the machine to
make the working table come forward. Remove the hexagon screw, turn the wax block
upside down and again fasten the screw. Again press the View button to disable the
View mode.
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Now in DeskProto click the lamp icon on the line of the second part to make that
current. Again in the Options menu -> Extra -> “Send current toolpaths to machine ...”
will make the machine start cutting side two.
For other machines open the second NC file in you control software.
You will see that after completing side two of the ring model an extra toolpath is added:
to create a small notch on the core support block. This notch allows you to distinguish
between both sides of the wax model and correctly align the model for side three. When
placing the wax model for the third orientation, hold the side with the notch.

When the toolpaths for Side 2 are finished, press the View button on the machine to
make the working table come forward. Loosen the hexagon screw, pick up wax block
and screw and place them on the reference pins at the right end of the fixture. Again
fasten the screw. Also again press the View button to disable the View mode.
The cutter should now be at Y=0 position. This is important as the toolpaths for Part 3
do not contain any commands for the Y-axis, and it has to be exactly above the rotation
axis.
Now in DeskProto click the lamp icon on the line of the third part to make that current.
Again in the Options menu -> Extra -> “Send current toolpaths to machine ...” will
make the machine start cutting side three. Or load the third NC file with your control
software and send it to the machine.
After completing side three your ring model is ready for further processing.
You can remove the support blocks now or use them in the casting process.
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Tip 1:
At any time you can pause the Roland’s cutting process by pressing the View button.
For instance to remove the chips. Note that you have to be slow to open the door of the
machine: after pressing the View button it’s LED blinks for some time. You need to
wait for this LED to burn uninterrupted before you open the door. When you open when
blinking (or during machining), the Jewela machine goes into an Error state and you
will have to start all over again.
Tip 2:
It may happen that by mistake you send the wrong toolpaths to the machine. Then you
can immediately stop a Roland machine by pressing the View button, as explained
above. To abort these toolpaths two extra actions are needed:
- on your PC open the Print queue of the Roland Jewela (Start -> Settings -> Printers
and faxes). You will see three print jobs: delete all three by selecting them and pressing
the delete key. The two small jobs will immediately disappear, the large one remains
present.
- on the Jewela machine, press the buttons Up and Down at the same time. Keep them
depressed until the LED stops blinking. Now also the large job in the print queue will
disappear.
What you have done is clear the Windows print queue and clear the machine’s printing
buffer. Now you can send the correct toolpaths to the machine.

III.3 The 123WaxModel Wizard.
The 123WaxRing fixture can be used to create Ring wax models.
It can also be used for two sided milling of small wax models like pendants and
brooches: all using the same cutter and workpiece zero point as used for ring models. To
allow this a special wizard is available in DeskProto: the 123WaxModel wizard. And
also a different type of wax block: rectangular, with the holes not in the center but on
one side instead.

The instructions for creating two sided wax models are very similar to the instructions
for wax rings as just given. Follow the steps of the 123WaxModel wizard, and machine
the wax blocks from two sides. Not further explanations are needed. As you can see in
the illustrations above, very detailed results can be achieved.

20

Appendices.
A.1

Wax Block specifications.

Drawing of the three holes in the wax block, allowing you to create your own wax
blocks, either the standard size or any custom size.

The above drawing has been used to create the wax disks that came with your
123WaxRing kit. You are welcome to order new disks from your reseller or from us,
though it is also possible for you to manufacture your own wax disks. The shape of
these blocks is not protected: our business is making and selling software, not wax
blocks.
Important for your own blocks is:
- thickness should be exact
- top and bottom surface should be exactly parallel
- the two holes for the reference pins should have a diameter and position exactly as
specified.
The pins on the fixture are 2.0 mm in diameter, tolerance field -0.00 / +0.01 (hardened
steel). So when the holes are exactly 2 mm in diameter the wax will not fit on the pins
(depending on the accuracy of the bearings of your drill).
Other dimensions of the wax blocks are not critical.
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A.2

Fixture mounting specifications.

Drawing of the left side of the fixture (where it is attached to the machine), allowing
you to create an adaptor that suits your machine.

Centering of the fixture is achieved by the ridge around the mounting surface: a circle of
33 mm diameter, 2 mm high. The round surface of the fixture has been dimensioned
diameter 33 mm -0.02 / +0.0 Also see the section drawing on the right to explain the
positioning ridge. These data will make it possible to create an adapter the perfectly fits
the fixture.
The fixture can be mounted using three screws, positioned on a circle of 26 mm
diameter at 120 degree angles. See the Roland drawing below: the fixture has been
designed to fit that mounting surface
.

Roland JWX-10 rotation axis mounting surface.

An alternative is using the hole in the center of the mounting surface: this hole is exactly
centered, and features an M10 threading.
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A.3

Adapter for Sherline-type machines.

Many USA-made machines (like Taig and MaxNC) have their rotation axis hardware
made by Sherline. The rotation table then features a threaded hole with it’s center
exactly on the axis of rotation. The hole in the center has a 3/8 inch UN 16 threading.
See the illustration below.

We offer the Sherline-to-Roland adapter: an adapter to connect the 123WaxRing
fixture (or in fact any other fixture for a Roland machine) to this rotation axis.
The adapter is an aluminum part, featuring:
- one threaded end (with centering guide) to connect to the Sherline rotation axis
- three set screws to prevent the unintentional unscrewing of the adapter
- one side that is identical to the Roland rotary axis: a countersunk mounting surface
with three M4 threaded holes.
The set screws can also be used to fine-tune the alignment in case needed.
See the illustrations below.

The hole that has been made diagonally through the adapter can be used for more grip
when screwing and unscrewing the adapter.
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